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Welcome to your Word Intermediate training course 

 This Microsoft Word training course is designed for those users who wish to 

improve their current knowledge of Word and take advantage of the more 

complex features.  

 You will be able to divide a document into sections and columns, to format 

tables and populate them with data directly from Excel spreadsheets.  

 You will also learn how to add recurrent data to documents in a series such 

as page numbers and headers.  

 Finally, you will be shown how to prepare labels and envelopes, add your 

company logo to a letter and set up a template for future mail.  
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Unit 1 Working with sections and columns 

In this unit you will learn to: 

Use various types of breaks (column, continuous, next page section) to create 

sections in a document. 

Format text into multiple columns.  

Enter and sort text in columns. 

Sections 
Create different sections in a document using various types of breaks. 

Place your cursor where you wish to insert the section break 

Go to the Page Layout ribbon/Page Setup group and click the Breaks button. 

Select the type of break you wish to insert. 

 

 

 

 

 

 

Section break type New section will begin 

Next page On the following page 

Continuous On the same page  

Odd page On the next odd numbered page 
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Columns 

Format text into multiple columns  

Select the text to be formatted in columns. 

Go to Page Layout/Page Setup group and click the Columns button. 

Use the More Columns... option to create more than three columns, change column 

width or spacing. 

 

 

 

 

Enter text in columns  

1. Click within one of the columns where you wish to enter text and begin typing. 

2. Text will ‘overflow’ into the following column  

 

 

 

Even page On the next even numbered page 
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Inserting a column break 

Click at the start of the sentence you wish to appear at the top of the next column. 

Go to Page Layout/Page Setup group and click the Breaks button. 

Select Column from the list of options. 

 

 

 

Sorting columns 

Select the column text to be sorted. 

Go to Home/Paragraph group and click the Sort  button. 

Select Paragraphs and Text, and sort option (Ascending or Descending). 

Click OK. 
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 

 

 

E  

 

 

Unit 2 Formatting tables 

In this unit you will learn to: 

Modify a table by aligning text, merging cells, changing text orientation, and resizing 

rows and columns. 

Highlight table cells by adding borders and shading. 

Use the Table Styles command to format tables and set a default table format.  

Creating a table 
Go to Insert/Table group and click the Table button. 

Either: 

Select the number of columns and rows required from the grid, or 

Use the Insert Table option, specify number of columns and rows and click OK. 
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Modifying a table 

Aligning text 

Select the table text to be aligned. 

Go to Table Tools Layout/Alignment group and select the alignment option you wish 

to use. 

 

 

 

 

 

 

 

Merging cells 

Select the cells to be merged (joined) together. 

Go to Table Tools Layout/Merge group and click Merge cells. 

The selected cells are now joined together into one cell. 
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 

 

 

 

 

 

 

 

Shading 

Select the cells you wish to apply shading to. 

Go to Table Tools Design/Table Styles group and click Shading. 

Borders 

Select the cells you wish to apply border to; or remove borders from. 

Go to Table Tools Design/Table Borders group and click Borders. 
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Shading    

   

 

 

 

Borders 
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Using Table Styles 

Applying a table style 

Click inside the table. 

Go to Table Tools Design/Table Styles group and click on a Table Style to apply the 

design to your table. Use the dropdown arrow  to the bottom right of the visible 

Table Styles to view further options. 

 

Setting a Table Style default 

Right-click on the Table Style you wish to set as the default. 

Select the Set as Default option. 

Select the default table option you wish to use (for this document only, or all 

documents based in the Normal template). 

 

 

 

 

 

 

 

Sorting Tables 
As with text paragraphs, tables can be sorted also by clicking the AZ button. 

Sorting by a single column 

For example, suppose you want to sort the table below by Status. Click inside the 

table and click Layout, Sort (AZ). 
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Name Dept Status Salary 

Ansell Admin FT £21,000 

Brough Sales FT £18,000 

Brown Finance Casual £8,000 

Brown Admin FT £21,000 

Brown Finance PT £13,000 

Butler Admin Casual £8,000 

Corleone Sales PT £9,000 

Cross Finance Casual £8,000 

Davies Sales Casual £8,500 

Francis Training PT £8,500 

Gallagher Sales Associate £45,000 

  

 

Note that Header row is selected as this table contains a header. 
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When you press OK the table becomes ordered by Status in alphabetically.  

Name Dept Status Salary 

Gallagher Sales Associate £45,000 

Mackenzie Sales Associate £36,000 

Perry Sales Associate £45,000 

Stein Operations Associate £42,000 

Brown Finance Casual £8,000 

Butler Admin Casual £8,000 

Cross Finance Casual £8,000 

Davies Sales Casual £8,500 

Hills Marketing Casual £10,000 

Hook Sales Casual £8,500 

Kani Sales Casual £13,000 

Morris Operations Casual £8,500 

Mountford Admin Casual £8,500 

Ryder Sales Casual £8,500 

Sandford Finance Casual £8,500 

Tate Finance Casual £8,500 

Ansell Admin FT £21,000 

Brough Sales FT £18,000 

Brown Admin FT £21,000 

Gilbert Finance FT £18,000 
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Sorting by Multiple columns 

To sort by more than one column, for example Department then Status click in the 

table and select Layout, Sort (AZ). 

 

Choose to sort by Dept and Then by Status.  Click OK and the table will be sorted as 

required. 

Name Dept Status Salary 

Butler Admin Casual £8,000 

Mountford Admin Casual £8,500 

Ansell Admin FT £21,000 

Brown Admin FT £21,000 

Lang Admin FT £12,500 

Mayer Admin FT £18,000 

Squire Admin FT £32,000 

Stephenson Admin FT £18,000 

Tate Admin FT £15,000 

Wren Admin FT £32,000 

Sharp Admin PT £24,000 
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Name Dept Status Salary 

Brown Finance Casual £8,000 

Cross Finance Casual £8,000 

Sandford Finance Casual £8,500 

Tate Finance Casual £8,500 

Gilbert Finance FT £18,000 

Matthews Finance FT £58,000 

Brown Finance PT £13,000 

Mills Finance PT £7,500 

Mills Finance PT £6,500 

Noble Finance PT £25,000 

Tott Finance PT £9,600 

Hills Marketing Casual £10,000 

Stein Operations Associate £42,000 

Morris Operations Casual £8,500 

Sumner Operations FT £35,000 

Gallagher Sales Associate £45,000 

Mackenzie Sales Associate £36,000 

Perry Sales Associate £45,000 

Davies Sales Casual £8,500 

Hook Sales Casual £8,500 

Kani Sales Casual £13,000 

Ryder Sales Casual £8,500 

Brough Sales FT £18,000 

Humphreys Sales FT £15,000 

Lewis Sales FT £16,000 
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Name Dept Status Salary 

Stephenson Sales FT £14,000 

Repeat Header Row 
A very useful feature of Word tables is the ability to repeat the header when a table 

spans over several pages.  This is particularly useful as it avoids the need to copy the 

heading and making adjustments if rows are inserted or deleted. 

To repeat the header row, click anywhere in the first row and select  

Layout, Repeat Header Row. 
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Unit 3 Working with imported data 

In this unit you will learn to: 

Import an Excel workbook into Word  

Use formulas to perform calculations in a table  

Move tables in a document 

Import an Excel workbook into Word 
Go to Insert/Text group and the click Object button. 

Select the Create from File tab, and click Browse. 

Select the Excel file you wish to import data from, click Insert then OK. 

Data from the first sheet in the Excel file is imported into the Word document. 

 

 

 

 

 

Notes: 

When you double-click on the table, the spreadsheet data can be edited using MS 

Excel features. 

Linking an Excel workbook to Word  

If you wish to create a link between the Excel spreadsheet and the imported data in 

Word, check the ‘Link to file’ box before clicking OK in step 2 above. 

Display as Icon 

In addition, you may wish to display an Excel document inside a Word document as 

an icon. 
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Using formulas in a table 
Click in the cell where you wish to create a total (or other calculation). 

Go to Table Tools Layout/Data group and click the Formula button. 

Check the Formula box, select a number format if required and click OK. 

 

 

 

 

 

 

 

 

Notes: 

SUM refers to the SUM function, which is used to add numbers together. 

(ABOVE) or (LEFT) refers to the location of the cells containing the numbers to 

be added, in relation to the cell where you are creating the formula. 

The Paste Function dropdown box can be used to select a different function, 

e.g AVERAGE to create an average instead of a total. 

 

Moving a table 
A table can be moved with the mouse (drag and drop) using the icon that appears in 

the top left corner of the table, as shown below. 

 

Alternatively, click on the icon shown above to select the whole table then use Cut 

and Paste to move the table.  
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Unit 4 Using Styles and Building Blocks 

In this unit you will learn to: 

Use styles to format text in documents  

Modify and delete styles  

Use styles to create outlines  

Use Quick Parts 

Using Styles 

Applying a style 

Click into or select the paragraph you wish to apply the style to. 

Go to Home/Styles group. Click the dropdown arrow  to view all the styles 

available in the Styles gallery. 

Click on the style you wish to use to apply the style to the selected paragraph. 

 

 

 

 

 

 
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Modifying a style 
Click the Options button  in the bottom right corner of Home/Styles group . 

The Styles palette appears on screen. 

Hover your mouse over the style you wish to modify (i.e. change the appearance of). 

Click the dropdown arrow to the right of the style you are modifying. 

Select Modify. 

Make the desired changes to the style. 

Click OK, then OK again. 
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Deleting a style 
Click the Options button  in the bottom right corner of Home/Styles group . 

The Styles palette appears on screen. 

Hover your mouse over the style you wish to delete. 

Click the dropdown arrow to the right of the style you are deleting and select Delete. 

Creating an outline using styles 

Go to View/Document Views and select Outline. 

The document appears in Outline view, and the Outlining ribbon appears at the top 

of the screen. 

 
 

 

  

 
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The group of buttons shown below allow you to change Heading styles currently 

applied to selected paragraph. 

 

 

Text in the document can be collapsed or expanded to view either just paragraphs 

formatted with Heading styles; or to view all text. 

 

The Close Outline View button closes Outline view and returns the document to the 

view it was displayed in previously (usually Print Layout view). 

 

 

Creating a Table of Contents using styles 

One of the advantages of using styles in a document is that a contents page can 

created automatically.  Any changes made to the document headings or changes in 

the page numbering is then automatically reflected in the table of contents. 

 

To create a Table of Contents click at the start of the document and choose: 

Reference, Table of Contents 
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After selecting a style, the table of content will be inserted into the document. 

 

   

 

Updating the TOC (Table of Contents) 

To update the table of contents after changes are made to the document: 

Right click inside the TOC, choose Update Field and select Update entire table. 
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Using Building Blocks 

Creating a building block 

Select the text or graphic that you want to save as a building block.  

To store paragraph formatting (e.g. indentation, alignment) with the entry, 

include the paragraph mark ( ) in the selection. 

Go to Insert/Text group and click the Quick Parts button. 

Click Save Selection to Quick Part Gallery. 

Fill out the information in the Create New Building Block dialog box, and click 

OK. 

 

 

 

 

 

 

 

  

 

Inserting a building block 
Go to Insert/Text group. 

Click the Quick Parts button and select Building Blocks Organizer. 

Select the Building Block you wish to use and click Insert. 
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 
 

 

 

 

Notes: 

Any Building Block you have created and saved yourself should appear at the 

top of the list when the Quick Parts button is clicked. To insert, click directly on 

the item. 

To use items from the AutoText gallery, type the first few letters and press the 

F3 key to get Word to put in the rest of the entry. This will work provided the 

first few letters you type in are different from the first few letters in other 

AutoText entries. 
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Unit 5 Working with Headers and Footers 

In this unit you will learn to: 

Create headers and footers 

Create section headers and footers 

Add page numbers to your document 

 

Accessing the header/footer area 
Go to Insert/Header & Footer group. 

Click the Header button or Footer button, then select Edit Header or Edit Footer. 

First page or odd and even page header/footer 

Go to Page Layout/Page Setup group and click the Options button . 

Select the Page Layout tab in the Page Setup dialogue box. 

Check the desired option from within the Headers and Footers area on the Page 

Layout tab and click OK. 
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Section headers and footers 

Create a header or footer for Section 1. 

Go to Header & Footer tools Design tab/Navigation group and click Next Section. 

This will take you directly to the Header or Footer at the start of the next section in 

the document. 

Before editing the header or footer of the second section, un-click the 

Link to Previous button in the Navigation group. This ensures that the header in this 

section can be different from the previous section. 

Edit and click the Close Header and Footer button. 

 

 

 

 

 

 

 
 un-click 

 

 

 

 

Page numbering 

Go to Insert/Header & Footer group and click the Page 

Number button. 
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Select Bottom of Page and choose from one of the preset options to select where 

you would like the page number inserted.  
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Unit 6 Working with Graphics 

In this unit you will learn to: 

Insert pictures into a document 

Create SmartArt diagrams 

Insert WordArt and symbols into a document 

Create watermarks 

Use drawing objects in a document  

Create borders and add shading to text 

 

Inserting pictures 
Go to Insert/Illustrations group and click Picture. 

Navigate to and select the picture to be inserted. 

Click Insert. 

 

 

 



28                                         0207 987 3777                   www.MicrosoftTraining.net 

 

 

 

Inserting SmartArt  
Go to Insert/Illustrations group and click SmartArt. 

Select the SmartArt diagram you wish to use from the gallery and click OK. 

Enter text either directly into a shape in the diagram, or into the text panel to the left. 

 

 

 



 

www.MicrosoftTraining.net              0207 987 3777                                              29 

 

 

 

 

Notes:  

To add a shape to the diagram, use the text panel. Click at the end of the text 

entered into the shape before/above the new shape you wish to create and 

press Enter. 

To delete a shape, use the text panel. Select the text inside the shape to be 

deleted and press the Delete key. 

 

Below is an example of a Hierarchy Chart or Organization Chart. Created with 

SmartArt. 
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Inserting WordArt  
Go to Insert/Text group and click the WordArt button. 

Select a WordArt style from the WordArt gallery. 

Enter the text to appear in the WordArt style you have chosen. 

 

 

 

 

 

 
 
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Inserting symbols  
Go to Insert/Symbol group and click the Symbol button. 

Select a symbol from the items displayed immediately below the button, or select the 

More Symbols option to view further symbol shapes. 

Select a symbol, click Insert then Close to exit the Symbol dialogue box. 

 

 

 

 

 

 

 

  

Assigning a shortcut to a symbol 

If there is a symbol you intend to use quite often such as a  when filling in a form 

you can save time by assigning a shortcut to the symbol. 

After finding the required symbol click the button Shortcut Key 
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Click in the box Press new shortcut key 

Press the required shortcut (Ctrl+6 for example) and click the Assign button. 

 

Finally click close and the  symbol is now permanently assigned to the shortcut 

Ctrl+6. 

Some shortcuts already have shortcut assignments. For example, pressing  

Ctrl+then e  

inserts the symbol é. 
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Pressing ctrl+` then e 

inserts the symbol è. 

 

Creating a watermark 
Go to the Design ribbon / Page Background group and click the Watermark button. 

Select a preset watermark option or select Custom Watermark to create your own. 

If creating your own watermark, select Custom Water / Text watermark, enter your 

text and click OK. 

 
 

 

 
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 

 

 

To remove a watermark select Design, Watermark, Remove Watermark. 

 

Creating shapes 
Go to Insert/Illustrations group and click Shapes. 

Select the shape you wish to create. 

Move your mouse onto the page, click and drag diagonally to create the shape. 

 

 

 

  

 

Creating borders 
Go to Home/Paragraph group and click the dropdown arrow to the right of the 

Borders button. 

Select the Borders and Shading option at the end of the list. 
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Use the Border tab to apply a border to a paragraph; or the Page Border tab to apply 

a border to a page. 

 

 

 

 
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Text shading 
Select the text to be shaded/highlighted. 

Go to Home/Font group and click the dropdown arrow to the right of the Text 

Highlight Color button. 

Select a colour to apply to text. 
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Unit 7 Templates 

In this unit you will learn to: 

Use a template to create a document  

Create a template 

 

Using an in-built template 
Go to File and select New 

Click Personal. 

Select a template and click the Create button. 
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Creating a custom template 
Click the Office Button button and select Save As, then Word Template. 

Check the Save as type box and change to .dot if necessary, enter a filename and 

Save. 

 

 

 
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Notes: 

A .dotx file is a Word 2007/2010  template. Users of Office 2003 or XP will not be 

able to open this type of file properly unless a compatibility pack has been 

downloaded from the Microsoft web site and installed on their computer. If the 

template needs to be opened on computers using Office 2003 or XP use the .dot 

file format when saving the template. 

The default location for saving template file a local folder called Templates. If 

others need to use the template, consider changing the Save in: location to a 

folder on a network drive. 

Modifying a custom template 
Go to the File Tab and select Open. 

Navigate to and select the template file, and click Open. 

Make the desired changes to the template and click the Save button on the Quick 

Access Toolbar. 

Alternatively the current template file can be modified and then overwritten as 

follows: 

Create a new document from the template file (as outlined in ‘Creating a 

document from a custom template’ above). 

Make the desired changes in the new document, then go to the Office button, 

select Save As then Word template. 

Navigate to where the template is currently saved, and click on the template file 

to select it. 

Click Save and overwrite the current template file with the updated version. 

E&OE 

STL Training reserves the right to revise this publication and make changes from 

time to time in its content without notice. 
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Quick reference: Word shortcut keys 

Command Keystroke 

Bold Ctrl+B 

Close Ctrl+F4 

Copy Ctrl+C 

Cut Ctrl+X 

Exit Word Alt+F4 

Font Ctrl+D 

Font grow/shrink 1 pt. Ctrl+ ] or [ 

Help F1 

Hyperlink Ctrl+K 

Italics Ctrl+I 

Justify—Center Ctrl+E 

Justify—Full Ctrl+J 

Justify—Left Ctrl+L 

Justify—Right Ctrl+R 

Line-spacing 1 Ctrl+1 

Line-spacing 1.5 Ctrl+5 

Line-spacing 2 Ctrl+2 

List Bullet Ctrl+Shift+L 

New document Ctrl+N 

Open a document Ctrl+O 

Paste Ctrl+V 

Print Ctrl+P 

Print Preview Ctrl+Alt+I 

Repeat/Redo Ctrl+Y 

Underline Ctrl+U 

Underline—double Ctrl+Shift+D 

Save Ctrl+S 

Select All Ctrl+A 

Spelling and Grammar check F7 

Table—to column bottom Alt+PgDn 

Table—to column top Alt+PgUp 

Table—to row beginning Alt+Home 

Table—to row end Alt+End 

Undo Ctrl+Z 

 


